SIEMENS

SIMATIC BHFITRMRNBEFEH

SIMATIC Software Authorization Introduction & Application

Getting Started Edition (2007 5= 7 H)




Excellence in
Automation & Drives:
Siemens

SIEMENS

W B

AR SRS A TR BA T AH DG )

SIMATIC #1535
PRIV ) IE25 5H 2 1R (1 X 31

R AT

PSR

BT HRIR IO VAT IR A5 3] PC
PR BRI FE AR B A

N

R
BATs B VPRTUEESEH: SRUE B AT
Key Words

Software; Authorization; License Key; ALM; AuthorsW

A&D Service & Support Page 2-31



(a;aﬂe&n;e‘m
et ) SIEMENS

H =
1. SIMATIC BB IE G A . oot e 5
Lol BB . oot 5
1.2, BRI I B T T R ] ettt et e 5
1.2.1. $ZRU2RUEHE (Authorization) ...t e 7
1.2.2. VFAfIES 4 2KUEH] (License Key) oot e 7
2. AFFFEAL (AUTHORIZATION) . ueett ettt et e e e e e e e e e e e e e e 8
R R 5 - 8
2.1.1 B 8
R = 7= 9
P > 5 & - 10
AR 7 ' = ¢ S 11
3. FHHVFREZEEH (LICENSE KEY) ottt et e e e e e e e e e 11
3. . U E BB . 11
3.1.1 B 2 11
3.1.2 B 11
3. 2. U E B EATE G . . ettt 12
3.3 YR E B B . o 12
4. REEF. BB B B IR P CH e 12
4.1 . =5 v < 13
4.2 B BT . 15
4.3 [0S 5 v 16
4.3.1 LEPEPC AR TFFUE (FFUE) ARB5. 16
4.3.2 TEHFRPC FAE G SR . 18
4.3.3.  AEURPC A B m A D . 20
4.3.4. FEHMRPCLMGERA B AT EZRE] . 22
o 2R o o IR =] T 22 e = =1 24
B, B R . o e 25

A&D Service & Support Page 3-31



(&aﬂe&n;e‘m
et ) SIEMENS

6.1. BB RSIMAT I A B R T A o e e 25
6.2. IGETRAEIN G 25 TEIEN, HRETERENBENEFINRRAER ...... 25
7. BB O R R . e 27
8. B —HETE AL . ettt e e 30
8. 1. Tl I F B EERAN IERAR T e 30
8.2. WMIRBHITFEIIMEE =M R . 30
8.8, BRI i T B o ottt 30
8.4, T AR IR . ot 30
8.5. Tl I F BRI B s et e e e 31

BHEWRIN: ACIBORTJIA, DREAEAITE . BUEEREFHHE—KE, 2ES%
Siemens FIFRE B REA M BRFHHEAT = i BIIE RUANIT 22

A&D Service & Support Page 4-31



Siemens SIEMENS
1. SIMATIC %A% 54 2%

1.1. BRHHZ

N T W ORAT N R AR IE AR, A Z0HE 222 SIMATIC BRAFHRREAR L 22 A N AL o
P15 22 7] ) SIMATIC HAT (R BV AR 2 P12 S AU R S ), HBERIZEAS SIMATIC 4k
BREFPREATE B

E3hia Bk bR

DOS #Z AL Authors.exe

B AuthorsW

VF ]k EH ALM (Automation License Manager)

1.2, BEBRYFREZE A AKX 5]

VOT T FRAERRRL 0 I WiFh: #2480 (Authorization) FIVFA]iE% 4] (License Key)
HUHFZAHS & Authorization, #ZAUH BEFE A W (B (BBt EORAFRIE 5, JF

HHBEAE PC MU AMAEAE 1) 73 X Bl 28 IR A 2% b e 28 M AN RELE USB frfifi o Faede. %#%

B AT =P e AR 8. — MR ATIES A 10 M 407 . Aaha% L "ID: KHE”

Frzso 481 AuthorsW (% Automation License Manager #4745 3. b aF sk B4 HAE

LB ERE AR 2L, LIS 1-1,

& 1-1

VFTuE% 4 (license Key) JEPETTF )8 FHIHT AL, V1o Uk 2 S A BE AR P A5 B (1) 4K
AR, HEEEHSERRATAE ) PCIPG EAB K . VRl ik S5 A6 A R 44 1) i SRR A B 2 5 2%

A&D Service & Support Page 5-31




m‘engﬁe_m ‘
ogpnctinec) SIEMENS

Ko —AMVFREB P VA UE S5 17 20 7407« {fH] Automation License Manager 4T #
L, REEAET AuthorsW,  Hidrfi & £ Fhko,
LERIPIIITE
o WAL, BAARE AT "Lic-No.” ARl BRELUE AT B M. H AT 2R AR
it 7. WL 1-2.

K 1-2
o U, B/ DE SIMATIC AR X A4t 7720, #ll: STEP7 Professional
Edition 2006; Teleservice V6.1 2%, L& 1-3.

A&D Service & Support Page 6-31



(;&f) SIEMENS

o XAEAFIFHER AR BE LR HES MKE. FeiES BaTE B3hiF
AiFEEAFF (Automation License Manager). —ANEZBUFTIESHA 10 My,
—AMNF AR HARETTIESH 20 A5+

1.2.1. #4538 (Authorization)
PR FE LT PR

o ARUERAL: AEJUINETCRR . T ASERE AL B M 2 RS g ke, ANBEAE USB frfifidt
e, PRAFAET O RO A L. WK 1-1.
o REITBL AHMREIREN 14 K, W E IO SN A FAT I T AR VTN o AERAR A
JHE SN, AT LU S SR AU . DR e (i an (b, W 1-1
fr: NMERDEORBIERECRE, HRNREA F— R MR ERIUNR 2%
o BB IBEIFBE ERIRERIX 2. RRAXTBL R R MR 2 h L f; Xt
B A2 N E A,

1.2.2.  WAMHEFEHS LU (License Key)
VEATIE A5 LR JURh A

e H—YFH[E (Single License) : JGMRGIREH A HAEAAEM— A HENL B, LI
171E USB frfifids I, AReilid g ALk .

o RAVFWHE (Trail License) : &G TAEVE TRV ] FAHOCIRAT BRI Sh BE T
e WHVFAIE S I CD 2248, it SBrlt) SIMATIC BRI & R 3K
W ARVFRIE SRVFSAT 14 Ko WA DA Z B, iR 2 S, i
VPR HENER . W SR R4 I AR 0 PE, RGeks Aghaf i vrnT e ], 2K
REESEVFATIE R AE . A VFRHEA eI R Sk k8 5 o

o MAHFAE (Rent License) : MUAUHE/RALTIAHIE SIMATIC i AF 1) % 7 Rk FH I A
VERMEER, % VF AR e Vi 50 AN/ . A SIMATIC #4F)3 shi TP ah v, 5
IR 1T

o EBWVFAE (Floating License) : Joflf AR FH I iRI BRI, 7T AMRAFAE USB
Frf s LA M ARRAE ] . BEAN, R 2 & PC MBI MZ S0 AFREE, 0] A
T P 25 L 10 07 SR S VE T UELE M 2% A L2 AT o AR TG IR AR A AL 2 1Y
EIEAEH], FERm ), RS ELEAE ), AR R .

1AM VF AT UEEAE PSR AAAL . 1 K AARAERAL: 19K B SIRA . LT AL
(Authorization) FIMFIEAL, FUZHIEAEAFMESE LT, WK 1-2. AHES)
VERIUE R RE LA B PR A, AT SR BB . 2RV IR H i s 2 . B
IR E .

A&D Service & Support Page 7-31



Excellence in

(&j) SIEMENS
WA SEEL I 5 A 32 W, 4.1, E ARk .
AT SEIR I 8 L2 S e 4.2, IR,

o  FLKFTHE (Update License) : 5575 B M R A6 5 30 ROAS T 20 281 558 1R ik
A, AT LU R AR AR A T VF AT e (B R 5 TN FH 07 D S PR AS 1) 3
E R R o FHRGERJE, IHRIVFRTIE A Zhamiky, Ha RV niEfere. 7t
456 B IR VE AIESS [F) FY7 8 VERlE . Bilin: C &/ STEPT V5.3 [itA LA T 1)
P AT BISTEPT V5.4, W LU JESTEPT V5.4 T4 V/Fn[iE: 6ES7810-4CCO08-
OYES5. Wi AV iES W,: 3.2, Vil k% T4

e POWERPACK ¥HJAE: iXJ&—FP LB IR VE AT UE, SIMATIC BATFANE, VFafiE
(f BARS SCAR—FE. #lln: STEP7 V5.3 POWERPACK ¥ r[ il f] T-714% STEP7
LITE V2.0 #| STEP7 V5.3 ; 2006 Jix SIMATIC NET ' IE SOFTNET S7
POWERPACK VFiJiE T3 FF 9 £ 64 ALK WIER: . BT 2 T BefHs 2
NG DL E o

PAEVFATIES R R 4 AN, B —Inhia) HEgE— & PC _HA#

e Unlock Copy License: UCL Z:f& T VFuJ k£ (1 fRE], UCL nJLAYEZ G EL L
ZREEs, JAETHEIAL e UCL #2451 Unlock Copy Key BLG, 1N K #44wt o]
DATESA VPR UE IS R 384T . HSpust & 6% 2 /N0 Vel ik . Hh a8 il
UEHCR 2/ 20 . UCL AEHRRIR,  H v AR 5

2. f#FH## (Authorization)

2.1, WM
AT AuthorsW

FERBCH RS ] 3 B AT AuthorsW 2.5.2,
BEREUR ;. http://support.automation.siemens.com/CN/view/zh/114358

21.1. B3EE

TE2%% SIMATIC B Rerh, 2R s s el UIN AT DL PR DUAE 202k sl gk
RELUS 23, WERGERe 7 IAE 2%, SR IEGIRISRBUCRAL, BRI NIRRT, /i b
&y Priti A S AR B . WA AEATHEL, Bl T AN ERRHEAK

A, AN S SRR N IR A BB A

N

A&D Service & Support Page 8-31


http://support.automation.siemens.com/CN/view/zh/114358

(f{') SIEMENS
X3 FBLAEAE AL USB 77/ %8 FIOVFATUE, F13) s B e il LA, S B USB 17
X I AT AT L
T VFRNES Y S AN A s L dd fd e e FE b . WK 2-1.

i SIMATIC iMap Setup

Required License Keys:

%) Yes, transFer should take place during the installation
(I Mo, Transfer License Kevs later

Transferring lice

Erom Te |2 Cy (v

][ Mext = ] [ Cancel

2-1

2.1.2. Fahiik
FELHESIMATICHR A RE A, W B 2R, WHE R D R T8 . i RPCHLEA

WK, SR 4. R VERTUE SR B SR PC
1. K EBURAE IR N BB IR S 4%, AR )53 Windows JH 3. Start > SIMATIC >
AuthorsW > AuthorsW, #T7F AuthorsW F£/7.
2. 1t Transfer Authorizations #5257, AP FIZIR ) — A b G PR AUITE ISR 5 2%
(W, LIRS
3. AR AR HRIKEN A . DAL, AN IRE) A T ) AR R
*o

A&D Service & Support Page 9-31



Excellence in
Automation & Drives:
Siemens

SIEMENS

=Y AUTHORSW - Authorizations on Drive
Fil=  Edit Authorization Wiew Option: Help
2] 2] ] 2 2
M anage Authorizatio Transfer Authorizations |
S -
P _ I Counter I W alidity
E 1 Unlirnited
X SIK/SIMATIC STEP 7BASIS VA1 ... 1 14 Daps
L2 SIEASIMATIC S7-PLCSIM WE.x 0 [ rlimited
Kl 2-2

Al

2l

bk

|gmx

Product

4. JEPEARIFRBL RIERIEEBCR SR 2 H b AL &, ol “ 7 $lel “—

7 AGHL S SRJE AT AT DASC PR A

2.2. BHITH

1. DZUESF LR R “IHRAL W2 TAISRH “IHRBURAL” Lo e R AL

MV AL EE ] “ IR ERBURAL” T
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SIMATIC > AuthorsW > AuthorsW, fT7F AuthorsW /7.

2. 1t Transfer Authorizations %51, 1E$%413 4 Source Drive #l Target Drive(%k
IR E ) o

3. Ml =7 FREEL 7 FR. PR R ACK AR BT IR S AR

3. MAWE®S (license Key)
3.1, WAMEZEHARE
I E: Automation License Manager
TS5BS TG 1] 1 B AU PR Automation License Manager 3.0 Hotfix 3.
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3.1.1. HZh%E
H h et FL R 2.0.1 FEAUT E Bhaedt.
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A BESIMATICHR AR FE R, G A 2235428, WL IR D BRI T 8 . I SRPCHLEE
WOK, TED. 4 LB VET RS R K PCH .
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2. ik Windows JF453 . Start > Simatic > License Management > Automation

License Manager, #JJI Automation License Manager #£/7 .

3. MEFEVF AR PIPTLE A AT K SN 4 -
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4. WPEEAEIAIVERIER Y], H RSB H AR oKsh L.
5. BEVFANIER P CAfBIR T .

3.2. WANEFHAR

1. J#id Windows JT-4f3% 5. Start > Simatic > License Management > Automation

License Manager, #J7JF Automation License Manager f£)¥ .

1%+% View > Management ¢4, HEA Management ik /4],

K IF A R VF AT UEFI THVF TR N SRR AL ) — 23 X L.

PRI VFATIE G RIGVERTIE) S

%E# License Key > Upgrade a4, $UTF .

o WG ATHYAEI, TR LAREAT T AN 2 IR A B SO0 1A

o WIRAEZATIETN, License Key Upgrade HGHEST JTo ZEXFiEHEH, k5
HATII T+, il Upgrade %41 .

o > W DN

33 WHIEEHIH

1. J#iT Windows JF4f% . Start > Simatic > License Management > Automation
License Manager, #]7F Automation License Manager F2/7.
2. IEFEVE TR TR A AL 4y X

3. P HREBSNVFIIERE Y], BRI R E R B AR sh . iR U
)ét«"

It o

4. VFATIEE T R

4. FZERH. FANEEHBBE KKK PC H
RO FARL VRT3 B 1K 22 B0 BRSO 0 T PC ML EAT IR 0 & o A H B B vr T
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WA USB 2 M5 5K X X
USB fifitige LS i, M— &AL B X
A B — & B R
N TR & T IR R A — AT ENL, B e )
LR AL IR I W 4 L
B TR A Ah— BT L, Bk xP xb

VORAETE A LB s F A TE A BE 2% (Automation License Manager) .

4.1. MgRLERE

1. J#iT Windows JF-4f% . Start > Simatic > License Management > Automation

License Manager, ]I Automation License Manager #£)7 .

2. 1EFf Edit > Connect Computer 3¢ Hdr4 . Connect Computer X iEHEFT I,

3. #y\ Computer Name, 5§ il Browse #4115 & M 2% Fal I PC. A R854 1)
LLf&: Computer Name. Computer Name.domain Fl IP Hihik,

Connect Computer

Specify the name of the computer you want ko conneck ko
(the Automation License Manager must be installed on this computer).

%]

mpUber narne:

) Browse, ..

(2.0, compuber name” ar
"computernarme, domain®)

[ Add ko search list

Display name: [139,24.226.63

(2.q. "my_licenses")

[ Alwaws display in navigation window

Cancel Help

4. fith OK ik,

5. FEZEMITR H Zikiyh C2e th Bl i PC.

A&D Service & Support

Page 13-31



Excellence in
Automation & Drives:
Siemens

SIEMENS

¥} Automation License Manager

File Edit License Key %iew Help

JB’-P|}{ EhX’HE‘ﬂ

=2- - My Computer

||License key

S sy () 139.24.226.63

-]

e —— ¢
e System (C:)
e Data (D) Swskem (C:)
e BrTcerse Key Download Data (D)
& 4-2

6. %E# File > Customize X H#.1i74. Customize X/ iHHEF] IF.

{f! Automation License Manager

8 Edit  License Kew  Yiew Help

K 4-3

Expott. .. Chrl+5 ||License key v| imE 9
Page Setup...
Prink Preview H .
i | License key - Data (D:)
@ | Farnily | Product
) = SIMATIC STEP 7 STEP 7 Professional Edition
Change Logon.. - SIMATIC STEF 7 STEF 7 Professional Edition
User Management. .. - SIMATIC STEF 7 TeleService V6.0
Exit Ale+Fa = SIMATIC STEP 7 57 Distribubed Safety

7. Bk Forbid license keys transfer from local computer. Forbid license keys transfer

to local computer FIILEIE. st OK A .

Customize

General | Fawvartes I

Arccess o remote comprker

w Forbid remote use of icense keps
Farbid licenze kevs transfer from local computer

[ JFaorbid license kevs transfer to local conmputer

Languange:

|English

] I Cancel Apply
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8. EFEAMMELL P X _EVFRUESY], M RbsERCE IR 4 PC BB IS 1, 58z
BUALIE . WA LLR 2% PCE R VF ATIE 3 PR R A A A

4.2. W&ILE
WRAEZ & PC R IMA ML RGBS PC L& FshvFnliul, nf DUl W 4% 32211
Dy RS E B Y AE . AR — %, R — G SN AE A, NRss . ff
PR LA LT

1. M 4.1, WEALIX 1 5 D e ik .

2. I%&F¥f File > Customize ¥ H.m4 . Customize X 1HHEF] FF.

¥ Automation License Manager
=N Edit License Key Wiew Help

Expart... Ctrl+5 & = |License key . | T ?
Page Setup...
Prink Preview . .
o el License key - Data (D:)
@ Status Family Product

) C SIMATIC STEP 7 STEP 7 Professional Edition

Change Logon... - SIMATIC STEP 7 STEP 7 Professional Edition
- SIMATIC STEP 7 TeleService Y6,0
Exit hle+F4 = SIMATIC STEP 7 57 Distributed Safeky
Kl 4-5

3. J:F% Forbid remote use of license keys &k, FRVFZFEHAVFAIE. FHEFER: A
H PC FH k45 PC #lit SR IX A BRI 23 B o

Customize [E|

General l Favorites ]

Access bo remote computer

ﬁurbid remote use of Iicense@

[v Forbid license keys transfer from local computer

[ Forbid licenze keys transfer bo local computer

Language:

|English =l
] 4 | Cancel Apply | Help |

A&D Service & Support Page 15-31



(E;I:.eﬂence_fn
gk din) SIEMENS
| Kl 4-6
4. P Favorites br%s, M rfr 2 BAT IR EhVERTUE K 4% PC, 38 3k 4 o v e AR S (1 4%
Hl, AR Z% PC 7E Search List 127k, Aili OK ik

Customize [g|
K.nown computers: Search list;

139.24 226 63 -+

139,24 226,78 —
i
¢
G

X

Ok | Cancel | Apply Help

K 4-7
5. AR e] DUEH A FHE s PC EVE BV al ik

4.3. BRfEE
AL,

1. {E¥ PC AR

2. fEH#bR PC LA &H KA ;

3. 7EYH PC LB AR

4. fEHb PC EBEEFZBET nT UE %5

4.3.1. 7B PC LAERTFFE FFEE) ARG

1. it Windows JF4f3 . Start > Simatic > License Management > Automation
License Manager, #J7JF Automation License Manager f£)¥ .

2. EFSEHm4 License Key > Offline Transfer. 77T License Keys Offline
Transfer X 1HAE

3. %% Generate Start Code, it Next. FJ7F Wizard for Sending License Key.
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License Keys Offline Transfer

Generate stark c@

(" Generate request code

™ Generate activation code

™ Activate license kew(s)

Which step of the offline transfer do wou want to execute?

Generates the start codes of the license kews on this computer,
They have to be transferred to the target compuker.

SIEMENS

Cancel Help

K 4-8
4. JITA Al HFRBCRIVE n] k2 H 1) T a4 s
TEPET BRI A B v IR H

Wizard for Sending License Key|s)

Display start code

Start codes were determined for the displayed license keys with
computer.
Select theli

be trangfered and save the license p

7t Display Start Code %1% H . M4IFH

which you can generate reguest codes on the target

rafile in a file.

oduct

P

4

| >

|D: WU gerghonl wpdy DhDesktopsTransferautolMList] . aut

Pritt

Save..
(l Mext > | ’ Cancel |

Help |

e e —

K 4-9

5. miili Save #%4, MEPEEASRALITIRAND .
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Save in: ||.f,‘ Transfer j & £ -

Fiename:  [AutaLMList1 [ sae |)

Save as lype: |I:Iffline license profile [7.aut) j Cancel

d

K 4-10
6. EHIIFHAE A2 HAx PC L.

4.3.2. 7EH# PC EAERIERNKE

1. J#id Windows Ff452% . Start > Simatic > License Management > Automation
License Manager, #J7JF Automation License Manager f£)¥ .

2. EFEEHMm4 License Key > Offline Transfer. #T7F License Keys Offline

Transfer XJi5HE .
3. %E#¢ Generate Request Code, i ii Next, #JJF Wizard for Receiving License Key
XFUHE o
| License Keys Offline Transfer E'

Which step of the offling kransfer do wou wank to execuke?

" Generate start code

@nerate request EDB

(" Generate activation code

" Activake license keyis)

Gaenerates the requesk codes, The start codes created on the
source computer are required for this, The created request codes
must be kransferred to the source computer,

e @ 00 00 Tm
‘ ' Cancel Help
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K 4-11

4. il Load #4#l, 7r Open XAGHEH BT PR A7 I R TF AL

Wizard for Receiving License Ks-rlﬂ.

Open 7

Start coded k @

Enterthe sf | ok i | £ Transfer ;j & &F E-

Product Ree= Re
[ oL mList 1 aut 00000...

, C I ™
File: name: IAutoLMLisH .aut Open )
—_—
Filez of type: IfoIine license profile [*.aut) _f_! Cancel |

-

|l

>

| MNext Cancel | Help

4-12
5. fith Open ##4l, FFarfti% L4 Enter Start Codes 413 H1.
6. riii Next #%4l, 17 Select License Keys 41/
7. ERRARATA BV AT UE B B R A M R A 3 X

Wizard for Receiving License Key(s)

!
I
!
| Select license keys
| Select the license keys to be applied by the source computer.
! e —
| ,%duct \ | License nu... | Start code | Re
L STEP 7-BASIS w54 004010000...  OESIF-LAT71-04050-40040...
< l >
e
‘which drive do you want to install the license keps to? Lacal Disk [D:)
LWty Compute
Local Disk [C:)
< Back I K Local Digk [D:]
I T

= e B B B

K 4-13
8. miili Next #%4ll, #IJF Display Request Codes %1% .
9. fiih Save $%fl, EPEEEIRIRATIE R .

A&D Service & Support

Page 19-31



Excellence in
Automation & Drives:
Siemens

Display req

Request codes
Save the licens
Determine the 3

Save in: i (3 Tranzfer

Product

STEF 7-BASIS

(=] AutaLmList1 2o

——

File name:

:-Lr-.-1Li:

Save az type: ]foline license profile [*.aut)

L] Cancel

e

o

SIEMENS
X

n
n
n
n
n
I Re
| JURSE-

i

Frint

< Back J

Cancel ‘

(e D

B

Help ]

10. B HIERACS SC 2R PC 1.

4.3.3. 1§ PC A RREIHEAE

1. i Windows Jf45% . Start > Simatic > License Management > Automation

K 4-14

License Manager, #JJf Automation License Manager f£)7 .

2. PR HM4 License Key > Offline Transfer. #1JT License Keys Offline

Transfer %G HE .

3. I&F Generate Activation Code, #JJF Wizard for Sending License Key X} iF4E .

License Keys Offline Transfer

" Generate start code

" Generate request code

C [+ Generate activation code :'

(" Activate license kew(s)

Mext = |

Which step aof the affline transfer do vou want to execute?

Transfers the selected license kevs to the karget computer. You
have to create the corresponding request codes on the target
compuker,

Help
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K 4-15
4. piili Load"#% 4, 7& Open XJiFAHE -b 4k 235 KA O A7 1) B AR Ik .

| Wizard for Sending License Key(s)

Enter reg

e Open B'E'
Load your i _ .

orreadinth Lok in: |E} Trarisfer Li & &5 B
Product ;

I Ste

1

File: narne: lAutoLMListZaut Open )

Filez of type: IfoIine license profile [* aut) ;} Cancel I

|~

K 4-16
5. fidi Open™#%4l, JFLAMASHIBLAE Enter Request Codes 4131,
6. st Next #4411, #JJF Remove License Keys 413 .

Wizard for, Sending License Key(s) |X|

Remove license key(s]

Determine the activation codes for the displayed license keys. You can activate the license keys on the target
computer with the activation codes. You then have to zave the license profile.

roduct _-‘\ | License nu... | Fequest code | Ac

LSTEP 7-BASIS V5.4 / 004010000...  180-260-ECA1-FOFD

Ve

|~

>

< Back I MHext > Cancel | Help |

4-17
7. fiili Save 44, ERBRAIRAFIIECHD
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8.
9.

Wizard for Sending License Key(s)

Remove license key(s]

Dretermine the activation codes for the displayed license keys. You can activate the license keys on the target
computer with the activation codes. You then have to save the licenze profile,

Product I License nu... | Request code | Ac
STEP 7-BASIS VB4 004010000...  180-260-ECA1-FOFD
Save As
Save in: IE} Transfer LI 4 & B

1] AkaLMList 1,2
i) AutaLMList2, aut

|

File: name:

e, >

T o I =

'_ Save... I
Save az ype: | Offling license profile [*.aut) _:J Carcel |

=

< Back | Iest | Cancel I Help

4-18

Sy Next™$%40, HiBL Calculate Activation Codes XA .
miihi Yes itk o BIAEAR Y A AL n] Uk % 3 @ ANEEYR PC .

| Wizard for Sending License Key[si

Remove license keyls]
Determine the activation codes for the displayed licenze keys. You can activate the license keys on the target
computer with the activation codes. You then have to zave the license profile.

Product =
32 F2:-TCIER Calculate Activation Codes: Confirm

This action will delete the license keys from the computer and the
activation codes and the activation codes for the selected products will be
displayved.

Are you sure you want to delete the license keys?

& : . £
IF:\Transfer\AutoLMListB.aut Save.. |

< Back | Mext » Cancel I Help

K| 4-19

10. SHEPBOE AR SR HAx PC L. sidds Finished, SCHIRTEHHE,

4.3.4. fEH#F PC EBUEFEF AL 4]

13T Windows JF45 5% . Start > Simatic > License Management > Automation

1.

License Manager, #JJI Automation License Manager f£)¥ .
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2. K4 License Key > Offline Transfer. 77T License Keys Offline
Transfer X} 1HAE.

3. IEF¥ Activate License Key, F]Jf Wizard for Receiving License Key X} 54,
| License Keys Offline Transfer E'

Which step of the offling kransfer do wou wank to execuke?
" Generate start code
(" Generate request code

(" Generate activation code

@vate license kﬂyD

Completes the license keys transfer and ackivates the license keys
with the determined activation codes,

Mexk = | Cancel | Help |

4-20
4. 5l Load %4, 7E Open XIiGHE ok BH0E AR (R AF I B AR I IE

Wizard for Receiving LicenseKeyls) ____[X]

Determine the

Enter the deterd  Look in: Jk‘:'} Transfer _:] - &5 BB~

Product | AutalMList1, aut -
= :

L ——
q

!
!
!
I Enter activ@lo)/[)]
!
!
!

i

File: name: iAutoLMListS.aut >

p—

Files of type; ;foline license profile [* aut] __V_j Cancel

|~

>

Load...

| e Cancel | Hep |

Kl 4-21
5. il Open #4l, FFUAALHS HILAE Enter Activation Codes 41| & .
6. riii Next #%4l, Z7~ Result 513,
7. il Finish Bl ALE5ER. AR D &AE5m 3 Hix PC L.
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Wizard for Receiving License Key(s) le

h
Result h
The license keys to be activated were entered inta the license profile. n
= Licenze nu... | Statis === [ [

< TEF 7-BASIS V5.4 004010000... EK/) h

(l Finish | ) | Help

e

K| 4-22

5. fi BN AR E PIE B S
N T G TR BRBCRIVF RIS B, 15 F IR S R I AT A«

1. b, FRAEEUR R IKEN 3 T B RRSH B E R AT, DRAFZAURIVF AT
.
o UMLK RESL LA B BIRAUKA L.
o A LAEJFOR I AR L ak USB #& L ARA7VF Al iE 2541
2. MFEFEE. . BEhETHEHN, NIZ eSS A R L BT S A R
Feo XIUHAEH T
o UPERET: HHEThEE, LWNVixAEH, 2/ERAER AZhBi.
o MBI BT .
e Windows 2000 A VARTIAS GRS AR5, Windows XP R3S B FE T
o ML/ F X
o JRAEFIKE
3. RIS (it Windows DA R AR RGeSO il 4 45 0 2 T, 1S IRAFHR
BV AT IR EH .
4, FZRURVF AR 4
o ANEAERAEIIKS) S FIBAT
o HEEAE R (LAN) NIZAT,
o ANAIFER BB (1 CD-ROM ) _LizfT.
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5. LARAR BRIV AT UE B I, HOR ORAFEAH IR B B R 48 H & “AX NF 22”7 i,
F AT LR H W @, #8380 S0 sl i S0P
6. W/ TEGE AL B ALy X AT CAnH Ghost IR G5 ) , st 3 iz
BLo
7. FRY, P NAZEGEETE R UL, B LT TR B p e

6. & LI &

6.1. LABIMA SIMATIC HAE RV ATIE 2540

. C4fE PC B2 TVFnIER A, nE RA 4R License Key cannot be found. 41
KU AN A H P 00, W] ORI FE30 Ve o ey fig v ?

fRIRTT S ARG VERTIER) STEPT A1 — N3 fh . LIS BRI B2 th T 30K 2
R . 7E % C:\Documents and settings\"User"\Application
Data\Microsoft\Crypto\RSA "~ aJ LR E]—ANLL 5-1-5-21-FF Sk I AE 5 K (1 SO 44
A A AL T A4 T WARK I SO o IR T R PR IS 2205, stnT AU
AR T

6.2. ImiIANENNE e T HEhHEA, ERG) Enin b S 2R ERE B
] #:  SIMATIC ARG IN AT 52 14 RIABOY, U SRAE I N BB 5 223 T e

WAL (BB, BN ETHEARED . RGN Sonilm i BB 3R E R,
YnAm] g e 2
R BUUMER “AXNF ZZ7  SCHEIEH (I I B2

1. it Windows JF4f3 . Start > Simatic > License Management > Automation
License Manager, #]JF Automation License Manager F£/F .

2. E R TERAUNIREN S (BN C AL, ALM AR CEDA TR AL AR . AT
T3 5 RS 1) R R I B, it EE LA AL R SCAF 44 (License Key) Al 20 A7 FVF AT IE
%45 (License number) .

3. WA SN R B AT IR IR B, W] LAl DU SR T B E View >
Define..., fTJF Define View XJ1ifiHE, {EXFEHE N [H#50%E4% Columns $r%5, K A=l
Y| FHMEHF ) License key F1 License number % 241, 4R 515 Edit view F iy 4% Jf: /4
o Apply #2411, L OK fifiihJ5, License key F1 License number P42 gt a] LA 7R 7E
ALM % I,
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Available views:

H

O

License key
Installed software

MNew | Copt

¥

| Apphy |
Cancel
Help

Clear |

Edit view

Name: | Test

Display in view;

~

Available columns:

=

Columns IFi\tEr ] Group ] Sort ]

Selected columns:

License type

Mumber of License Keys
User

Computer used

Hud cerial niimhar

Manufacturer had j Shatus
Crder number Farnily
Computer Product
Storage location ‘. Wersion

|
v %

Armount of software

License number
License key

4 6-1

4. 7F Windows HYREF IS, m e TR SES (Bl C &) NI H 3 AX NF
ZZ , AE DR BN A
5. WIHCRPEE TS AR H 3% AX NF Z2Z, XI] LU 338 5 Tools > Folder

options... JEPEAR%E View, R T H) SCfFJeiEm.. . p i
G AE SO (MR 7
b S M TN TR SR B

Rk I« Bz frd (1 3%

("Hide protected operating files(Recommended)") H(iH .

( "Show hidden files and folders™) . #X)5 sy

NH] (Apply) #413F midi OK itk X I SRS B gl ol LU 78 AX NF ZZ SCfF

H >

Folder Options

General |IViEW I | File Types | Offline Files

Folder wigwss

You can apply the view [such as Details or Tiles] that
you are uzsing for thiz falder ta all folders.

&

[ Apply to Al Folders ] ’ Feset Al Folders

Advanced zettings:

] Display the full path in the title bar ~
[ Do nat cache thumbnails 3
[ Hidden files and folders
() Do nat show hidden files and folders

Shaow and folders I
Hide extensions for known file types
Hide protected operating system files [Recommended) I
Launch folder windows in a separate process
[C Managing pairs of ‘Web pages and folders

(&) Show and manage the pair as a single file

() Show both parts and manage them individually

() Show bath parts but manage az a single file hd
Restore Defaults
ak. ] [ Cancel ]
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7. 3EH AXNF ZZ FSRHPIRIN S BOCEIF mdi A i, SRJEEFE “IHBR”

Folders
@ Desktop
mrjj My Documents
=] Q My Computer
= S System (C:)
5 AsnFzz

(=) [Z5) Documents and Settings

Kl 6-2
6. i I AXNF ZZ 15 ALM GBS B & 75 B I B2 AU S 44
(License Key) #H [ 3C 1.

X Marne

~| E|SIFLAICFCS0601 .ekb
| = SIFLS7PROFOS03.ekb
| SITTALPCIADSO3, ekb
| SITTALPLCSOS03. ekb
= SITTAISCL_0503.ekb

#5! Automation License Manager.

= My Computer
System (1)
Lacal Disk (D)
M nbios3ad

B EAA L.

7. BB HFAHEEHRE
FEAT PP A BV AT Uk S R o B 3 e B, 37 S HR TR I e M X R B Ak

File Edit LicenseKey ‘iew Help

S mp XX H = S| ?

Status | Family

SIMATIC STER 7
SIMATIC STEP 7
SIMATIC STER 7
SIMATIC STEP 7
SIMATIC STEP 7
SIMATIC STEP 7

I SITTA171040503 kb

License type
Trial

Trial
Floating
Floating
Trial

Trial

6-3

Size | Type

3KE EKEFile
3KE EKEFile
3KE EKEFile
3KE EKBFilz
3KE EKBFilz
3KE EKBFilz

License number

00000000000000000000
99999999939000000001
00401000002040279539
00401000018050275969
99999999999000000001
999999959999000000001

Date Modified

25.04.2006 14:45
05.05.2006 10:00
05.05.2006 0959
05.05.2006 09:59
05.05.2006 09:59
05.05.2006 09:59

License key

SITTALPDIADSOS
[ErTar7inats0g]
SIFLSYPROFOSO3
SIFLA1CFCS0601
SITTALSCL_0S03
SITTAIPLCSOS03

ARG, -

|LiE

HeE

|email

|k /2

+49 180 5050 222

+49 180 5050 223

|adautorisierung@siemens.com

XH

Toll Free

+ 1 800-333-7421
Outside USA

+1 423-262-2522

+1 423-262-2200

simatic. hotline@sea. siemens. com

TP/ BKF
b

+86 10 64 757575

+86 10 64 747474

adsupport. asia@siemens. com

RS VP ANUE T K ZEAT IR, WO SRR R . 2 Ja, THEOL R, M2
i Email B 1 EORE H AR BIA X AR TP

P PR BF AT UE B A 1 T O T
APEBFAL O] AR VR AT UE D IR, R T R VR T .

HR 3 2 BT AT R 2 AN TR
1. ¥R (Authorization) fEMEAEFRHILN, iS40

1) d

PUSHRIA AN Z R S DA, SR FEmg A7 AN -

U T B IR RE T

i Windows JF4532 8. Start > Simatic > AuthorsW > AuthorsW, FJJF

“AuthorsWi£% .
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2) BIRIFRAL N PC ALK 2% rh
3) EHPEREL T ER R B, R FE R SR a4 Authorization > Recover.

& AuthorsW

File Edit BN EEEEREN Yiew Fawvoribes Options  Help

% El Zheck,

Maove. .. F7
COffline Transfer...

Upgrade...
Downgrade. ..

hanage

Delete Inactive

i_;-? Show Hiskary, ..
g TrECEn DoTme
‘3 Offline Transfer

7-1
4) %WoR Recover Authorization X3 f, H i g & )77 20 Inquiry Code
YRR . BRUAZ I 2R F 1% Inquiry Code 221 Enable Code Jf45 7
/i \ Enable Code, siidi OK 5EAZAUIRA

Recover authorization

Name: |AIWARCT2

Froduct: |SIKHSIM.-‘-‘-.TII: WMCC User Archives

Inguiry code: £ |B91484 ¥
@enter the enable@

Cancel | Help

7-2
2. ML (Authorization) FERKELHIIN, DCHSANGE BRI TIKE . 7 75 B0 R A R 25 B A
WX AZACAER oLy, I PO AR R )5, TR AL 2 I P .
3. VFAIIE#4] (License Key) (EMERITP#IIAN, KGN AT E RS, KELRMWF:

1) i#iE Windows JF4f°% . Start > Simatic > License Management > Automation

License Manager, #JJF“Automation License Manager"f£)7 .

2) EFENHEHAr4 License Key > Recover
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{5 Automation License Manager

File Edit BEEGECNEEEE Yiew  Help

Transfer. ..

||License Key 1 v| Im| "_'}| ? |

Check Requirement:
CFfline Transfer...

License Key 1 - Local Disk (C:)

SIMATIC STEP 7
Upgrade. .. = SIMATIC STEF 7 57 Diskributed Safety
- SIMATIC STEFP 7 STEP 7-BASIS V5.4
K 7-3

3) /r Recover License Key i HE, )7l IR 1) 77 0% Request Code
YRR . 3Rl 2R $5 1% Request Code L1k Activation Code 457 /1]
S, N Activation Code, il OK S8 iF Al iFMK 5 .

Recover License Key

Enter activation code
Forward the request code ko Suppart and enter the received activation code.,

Produck: IiMap
License key: ISIFLMIMAPDSDD
License number: IDD4DIDDDDDZDD?DDSDSD

Request cade: ( |9?1EIBI )
Gonan o) |

K Zancel | Help |

7-4
4. VFAJIE%EH (License Key) FERKELHIIIAANEE HALHTIKE o FH /7 75 0B JR A5 R 27 2 A
X 2R Py, PR P RIE R R G, R TR A R

Feon e LA T L PR 8 AR AR VE AT R H LR WL, 3 SR oV B ) S R 2 5 A 1
FRAZABCEF AR PN, 35 A X BB IR o BRSO 3 B P 24T A
ks BUOREE T IR IE 24 A G
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8. Py —HErEM AL

8.1. 7117 B 5Kah™ M K TER B STHF

A DT ) Siemens A&D A A ST 5 ik -
http://www.ad.siemens.com.cn/service/
1] LAAER R B BN STEP7, MMC i Compatibility 2558, SREUHSCE &, st
s BUN BT BERIBCE 245 B

M AT, http://www.ad.siemens.com.cn/service/e-training/

ASH ) [n) @i :  http://support.automation.siemens.com/CN/view/zh/10805055/133000

ASH = &: http://support.automation.siemens.com/CN/view/zh/10805055/133400

KA ZASHIX : http://www.ad.siemens.com.cn/service/answer/category.asp?cid=1027

R LAy a1y CRED B3k 5804 B 3 liwww.ad.siemens.com.cn , 41
BT 7R o 2 3 R A ] DABRIE R R 7= B RN R G A S o

8.2. WHAIERTR T TF H AL 53N 7= I Sk
HoE, @il Siemens A&DIF M 2 I N 4. www.ad.siemens.com.cn

fib ] LAE L 010-64763726 R HU K.
FEh, B RKERT WA LSS e, 15 R

8.3. WEWZIERI KT’
WA W AR R AT 0%, BRI FA Al B i ] 8y . ey &y Anf
FH 010-64731919 3k75 .

8.4. T 1T HARSHRF ML
WA TEE BAT IR R BOR T 8, TR T U] BOR SRS 400-810-4288 17 010~

64719990 JEAT 1) L6 1L BAE FATTAI B SRR 15 k55 W i
http://www.ad.siemens.com.cn/service/ s “HAR SRS HEAT IR G E (i 1D, 5%
RRVUT T FRORSCH TR A o FRATSAE A — 2 8 1. 8:15 22 17: 15 Cy i H BRAM) AR
) AT AR o VYA T X600 1) 00 RS St P b 5 38 A58 P 7 ot RS 2R, DU RUPRA 21 471 33
P27 R LRI 3 B o

BRI 010-64719991.

FA S FFIB4: adscs.china@siemens.com 54008104288.cn@siemens.com.
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8.5. Wil ¥ Bahb=m e M

http://www.ad.siemens.com.cn/products/as/s7 200/ $#2£4tS7-200 PLCHI 1R S 8 AF R4
https://mall.automation.siemens.com/CN/quest/#t £k i [ ]+ H 24k 5 I & 1 T A7 7= i T B¢
S B EERSEL, SRR 3RS S M ilhttp://iwww.ad.siemens.com.cn/service/ il
R “AGD Mall”  EAAZ M BEREAT A il
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